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Software News
June 30, 2022

EAW Resolution v2.10.1.16 Release Notes
Previous Version: EAW Resolution v2.10.0.138

Added Support for KF210 Line Array

% Online Devices
ACe-DEMO

Updated Side View

Changes the Venue View to a defined X,Y location and rotational angle (the view is always vertical). This allows
the view to be parallel to the aim line of an array, the center line of a surface, or arbitrary user defined position.
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New SPL Models Feature

Arrays can be added to groups for specific SPL plots & mapping

I SPL Madels g X

] Main: All Arrays

L] Array

~ [ SPL Maodel 1
Array _é’ Rename

Array 3 K Remove

[] Enable Calculations A W

New SPL Distribution Chart

The SPL Distribution Dialog shows a chart of the SPL distribution as well as statistics computed from the data.

£2 SPL Distribution

SPL Distribution -- Broadband SPL A

Average =107.8d8
Std Dev =3.3d8

Min SPL =99.5d8
Max SPL =112.5d8

Low90% = 102.4d8
High 90% = 113.208

6.7% < 102.4dB
0.0% > 113.2dB

Percent (%)

Interpolation = Best
Sampling:
Spading =0.5m
Count =357

SPL 100 101 102 103
Distribution Sampling
Mn [93.5d8 |2 Spacng 108 (2]  spacng

Haxnim _-Cemnr V: Surface 10f 1

FitRange |

90 % of SPL = +/-5.4dB

100% of SPL = +/-6.5dB

x
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General Features and improvements

Show/hide coverage pattern in Design View

Export EASE xglc for selected item only

UXA Export Debug Logs

Improved Side View

Added SPL Distribution Chart

Added SPL Models Feature

e Improvements on AC6 Horizontal Mode

e Restructured View Menu, added new Window Menu

EAW Resolution v2.10.0.138 Release Notes
Previous Version: EAW Resolution v2.9.2.22

Added Network and Control Support for AC6

* Oinline Devices

ACE-DEMO Array Processing

Unassign All

Edit the array

Clane array
Save Array Preset

Lock

Remove

Improved Adaptive system health functionality
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2 System Health

Array

1: ACS-DEMO

Close

General Features and improvements

Improved venue detection.

Improved network communication for systems with a large amount of online devices.

Fixed UX/UXA mute buttons in Network View.

Improved firmware update process and reliability for daisy chained devices.

Minor bug fixes for ADAPTive Air Loss.

Remember which PEQ is selected when toggling inputs/outputs in Processor.

Disable or Hide "Coverage & Modify Coverage" for Non-Adaptive Products.

Resolution now should request and recognize the processor type in Radius hardware info response.

Firmware Updates

Initial release of AC6 firmware

SBX, NTX, RSX improved firmware to support latest hardware version

Update Anya firmware that fixed a bug that could cause a momentary (2-3 seconds) audio mute or
erroneous fault condition (rare case)

EAW Resolution v2.9.2.22 Release Notes

Previous Version: EAW Resolution v2.8.1.8

Added Network and Control Support for Radius

RSX12, RSX208L
RSX18, RSX18F, RSX212L
RSX86, RSX90
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RSX126, RSX129
RSX218

“ Online Devices

* Array 1
1: RSX208L-BPIM
2: RSX208L-BPD2

H% Hl -HE

DL32-HALTstation
DL32R-Pitlab
R1c-UxA-KF210-3
WHT-PIT-OME

Radius Driver Test implementation

Array Processing
Unassign All

Edit the array

Clone array
Save Array Preset

Lock

Remove

= -BPD1 *

[ Diagnostics: ANYA-01

ovevien [ Metera | Montenance | Towoa | | Erortog |

e Lozdng Notss...

Product
Software ersion

Frmware berison

1P Address

MAC Adcress

RXChames 0

R Latency

ToChames 0
TLatency

Ral ODdeyees
Pitch 00 degrees

Ovenvien

RSX208L-BPD1
Praduct
Praduct version
Saftware Version 1,1,

Driver Test off

TestType | Aulo e 3 3

Level 60.0d8 3
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£ Diagnostics: RSX208L-BPD1 X

Qverview

RSX208L-BPD1

Product RSX208L
Product Version 1.0.0
Software Version 1.1.48.0
Firmware Verison  1.1.48.0

Dante Version 2231
IP Address 169.254.110.11
MAC Address 0Ob:6d:f2:08:0b:6d

Dante IP Address ~ 163.254.151.4
Dante MAC Address 00:1d:c1:00:04:96
RX Channels 1

RX Latency 1ims

Angle 1]

LED Options

Logo LED |Off ~

Update Firmware

Reboot

Click “On” to start the
test

Driver Test

Test Type Auto HF MF
Level |

/

Select Passband to test

Adjust the Level

Radius Array Optimize implementation

& Equalizer - Array X

RSX208L Speaker Options

Op Mode  SAPPHIRE Voicing Rev A

Array Length Optimization

Air Loss Compensation

Processing Settings

Gain [0.00 cB +
Delay

Reset All [ Mute
PEQ Settings
Enable EQ
PEQ1| << Ees
Type Parametric ~
Frequency |47.4Hz -
Gain
Q | [2.00 S
Reset
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General Features and improvements

Acoustic model and SPL recalculate less frequently for venue edits
Network Stability Improvements for large scale systems

Speed, responsiveness, and usability improvements for large systems
Improved use of CPU and core split ups

System Health and parameter upload improvements

Bottom Height and clearance fields improved.

e Improved Firmware upload support (Including RSX Series Firmware)
e Improved support for “roll” of products

e Automatic reconnection to online devices after PC sleep mode restart
e Parameter copy/paste between processors and between channels

e Improved Undo/Redo feature.

e Added new Front View and ability to load front view elevation drawings.

e Resolution 2.8 will rotate the drawing 90 degrees if you resave the file.
o New data files for JF80z, JF60z, SB528z, SB250z, SB150z, SB180z, L5432i, LS832i, MK8126|, MK8196:i.

EAW Resolution v2.8.1.8 Release Notes

Previous Version: EAW Resolution v2.8.0.37

Adaptive Venue Detection Mode: Narrow or Wide.

There is now a new option under the Options menu.

¢ | Options  Teols  Help

Temperature and Humidity... €L "l‘ L o

Without Air Absorption

=

Auto-adjust SPL Range A
SPL Interpolation r
Side View Contour Lines r
Tep View Contour Lines r

Design Factor...

5l Units
® S Units

Yenue Measurements L4

®  Pax SPL
Flat SPL

Adaptive Venue Detection Method k Marrow
*  Wide

Eastern Acoustic Works | One Main Street | Whitinsville, MA 01588 USA | tel 800 992 5013 /+1 508 234 6158 | fax 508 234 8251 | www.eaw.com



=5 EANNA
Example:

One 10-modula Anna array aimed down a typical venue. One side of the venue is show for illustrative purposes.

[ Wide Nerroweawresolution - EAW Resolut B o, T

File Edit View Network Options Tools Help Debug

M) en [ e Be BoaQ o

Array View g x Project Explorer 8 x
b Venue =
4 Arays DIE)

[ Amay 7 R o AL
Processors & A.. (4[4
Drawings +

Properties

Property Value

Name Armay
4 Location  (0.0m,0.0m,100m)
00m
0.0m
10.0m
Bottom Hei... 7.0m
MaxHang  101m

Min Trim _ 3.0m 2

Desn Factar: 101 | Offine

Height Depth Aim Angle
3.0m 0.7m 0.0°

34m. -19.5m,. -0.0m) Lo 3

Here, the coverage is set to Wide

= IR T B o, TN

File Edit View Network Options Tools Help Debug

(X [Tl 8 ¢ QA @« 8 [=]am

Array View 8 x ¥ Project Explorer 8 x
b Venue = [E
4 Arays C|E)
&> Array bS]l ST
Processors & A... [+ 4

Drawings

Properties

Property Value

Name

Array
4 Location  {0.0m,0.0m, 10.0m)
00m
00m
100m
Bottom Hei... 7.0m
MaxHang  10im

Min Trim___ 3.0m 2

DesgnFacor: 101 | Offine

Height Depth AimAngle  Weight I
3.0m 0.7m 0.0° 646.3kg .o
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* Wide_Narrow.ea Hon - ol
Edit View Network Options Tools Help Debug

ALl 0 0QQA S b [mnd &+ O™

Project Explorer g
& Venue CEE]
4 Arrays HE
4 Amay XEOER
4 Array [col 1]
> Spatial E...
AFBAnna ¥
1: Anna (-4
2 Anna 24
3: Anna x
4 Anna X
5: Anna (-4
6: Anna 24
7: Anna x
8: Anna =
9: Anna (=4
10: Anna x
Processors & A... (4[4
Drawings £
Properties a8 x
Property Value .
Name Array [col 1]
Speakers 10
4 Location (0.0m, 0.0m, 10.0m) =
x 00m
¥y 00m
z 10.0m
Bottom Hei... | 7.0m
Height 30m
Depth 07m
Weight 646.4kg
HangStyle A
Tilt 01

Coverage extends to the side of the arena.

In this next figure the coverage is set to Narrow.

* Wide_Narrow.ea Hon - ol
File Edit View Network Options Tools Help Debug

Sl 0 0 QRQ @t ) Fnd + O

| Array View Project Explorer a
» Venue [CE[]
4 Arrays (=]
4 Amray (7)1 I
4 Array [col 1]
» Spatial E...
A:FBAnna 3
1: Anna =
2:Anna (=4
32: Anna x
4 Anna X
5: Anna (-4
6: Anna =4
7: Anna x
& Anna X
9: Anna (-4
10: Anna 24
Processors & A... (4[4
Drawings £
Properties 8 x
Property Value o
Name Array [col 1]
Speakers 10
4 Location (0.0m, 0.0m, 10.0m) =
x 00m
y 00m
z 10.0m
Bottom Hei... | 7.0m
Height 30m
Depth 07m
Weight 646.4kg
HangStyle A
Tilt 01
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* Wide_Narrow.ea ion -

Coverage is contained on the floor section.

Show Sweep Lines & Show Venue Detection

There are new options under the View menu.

View Metwork Options Tools Help

' ¥ Venue Configuration g
_I es  Network Configuration —ﬁ
3
T Free View Crl+1
Tl sideView Ctrl+2
fl 4 .
£ e, Top View Ctrl+3
~  Array View Window mn
[ ~  Project Explorer Window
ti ¥  Properties Window
@ Link Groups

Array Names

~  Aiming Lines

vi 3 3 3 3 m

~  Aiming Coverage Lines

~  Enable Calculations

srL SPL s
SFL SPL (mic only)

¥ SPL Map

Contour Lines
. Show Sweep Lines
~  Show Venue Detection

Frequency Response F

- % Main Toolbar S

¥ FileToolbar g
~  Edit Toolbar
‘Type  Anna

[of
Edit View Network Options Tools Help Debug
Kt [Fi . 8 9QQ @ b [Hnd + O
g i ; Project Explorer a8 x
I Venue 1
4 Arrays
4 Aray
4 Array [eol1]
> Spatial E...
A:FBAnna €
1: Anna (-4
2 Anna 24
3: Anna X
4 Anna x
5: Anna (-4
6: Anna 24
7: Anna x
8: Anna =
9: Anna (=4
10: Anna x
Processors & A... (4[4
Drawings =
Properties a8 x
Property Value i
Name Array [col1]
Speakers 10
4 Location (0.0m, 0.0m, 10.0m) =
x 00m
y 00m
z 100m
Bottom Hei... |7.0m
Height 30m
Depth 07m
Weight 646.4kg
HangStyle A
Tilt 01 -

Desnracor 101 | Offine

Eastern Acoustic Works | One Main Street | Whitinsville, MA 01588 USA | tel 800 992 5013 /+1 508 234 6158 | fax 508 234 8251 | www.eaw.com




—=[=/\\/.

Show Venue Detection

Upon selecting to view this option, Resolution will display a pink line representing how the venue is being
calculated.
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Show Sweep Lines

Upon selecting to view this option, Resolution will display a series of green lines showing which sections of each
surface are being covered.
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Improvements

Minor bug fixes relating to SPL recalculation engine.

o 0 o 00 o o O o 0 o O o0 O o o0 o

Remove coverage extension property for Otto

SB818F shouldn't default to a rear Op Mode

Extend Coverage has no effect when using the "Narrow" venue detection mode.

Adjusting the SPL Range triggers an acoustic model calculation

Reintroduce old coverage method as an option

UX High Shelf, Low Shelf, Xmax, Vx Limiter are not reset when greyboxes are loaded

Filter Settings differ from 2.6.1

Base Delay for a Greybox leg is being set to the leg's Gain value

Frequency Response window migrates down the screen each time it is opened

Pulling settings from processor fails and can crash Resolution

Regression: Processor Shelf/PEQ Filter Gain zeroed is not reflected in EQ View

Complete KF810 / SB818 / FB / AB Data Files

Filter "Type" is unexpectedly greyed out when adding/removing Greyboxes

Wrong frequency is displayed for the HPF after a sub Greybox is loaded.

Text on the second line of the Missing Greybox dialog is missing the output leg numbers

UX network device name is not updated when "Pull" is selected.

Characters that are entered on the output channel strips of processors/amps are erased when
clicking OK button in the Select/Configure Greybox popup window

Windows Stopped Working Error Appears When Attempting to Open .eawarray Files Via File >
Open

High / Low Shelf shape adjustments by mouse scroll not reflected in value field

RSX212L RSX118F EASE GLL

In Drawings Properties Pane for a Side View Imported Image Manually Entering a Z value of 10
Places Results in a 0 Value

UX name in the online devices list isn't updated when the online device is assigned to an offline
device with a different name

Right clicking on a mute button in Network View toggles the mute and brings up the context
menu

Add Greybox Name somewhere in Greybox Section and Perhaps on mixer

When creating a new Greybox the user should be prompted to assign an input if no input is
selected

UX amp or dsp mute button greyed out

For HPF, and LPF should be able to enter a frequency beyond the allowable range to set filter to
ouT
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EAW Resolution v2.8.0.37 Release Notes
Previous Version: EAW Resolution v2.7.0.8

Resolution 2.8 contains several improvements for modeling and support for new products. For any
questions, contact the Application Engineering team at design@eaw.com.

Key features in this release are listed below:
SPL Map/Adaptive Settings Saved with File

Acoustic SPL map and all steering settings are now saved with the Resolution file, allowing for quick
display of SPL map upon loading a file, and quick upload of settings.

[=] FlatVenue.eawresolution -
File | Edit View MNetwork Options Tools Help

;JNW Ctrl+N @\@\94,@5-1‘...4- oo JEH

=4 Open.. Ctrl+ O
% Open Acoustic Model...

Close

vl

Save Ctrl+5

Save As...

EEE

Save Acoustic Model...

Import...
Import drawing...

@  Export EASE File...

' Create PDF...
& Create CSV...

Recent Files s

Exit Alt+F4

Fig 1. Save Acoustic Model opfion

———
E Archive Acoustic Information u
.
Acoustic Model Built Ready
Surface SPL calculated 1 Ready
Side View SPL calculated Mot Ready
Microphane SPL calculated Mot Available I
E Save As... ] [ Cancel ]
|

Fig 2. Acoustic Info: display of what’s available to be saved
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E save ' Pe— .
- J—,-i Search Desktop PJ

Organize « Mew folder BT - (7]

457 Favorites
& Downloads
“El Recent Places

1

E

| @& OneDrive Bill Hoy

i Bl Desktop System Folder

Libraries
System Folder

m

Computer

4o Libraries Systern Folder

[» @ Documents

> & Music Metwiork
I (&= Pictures " Systern Folder
bl

B Videos
- Anna XGLC Work -
| File name: -
Save as type: | EAW Files (*.eawcab) v]
(@ Hide Folders | swe || cancel |

Fig 3. Save as *.eawcab

Improved Venue Detection/Surface Detection

Significant changes in adaptive algorithms and how venues/surfaces are analyzed. Improvementsin
both calculations and coverage for multi surface venues. Detection of the venue and any obscured
audience sections are significantly better than before, resulting in better adaptation.

All examples below: SPL - Best, FLAT SPL, 1 octave 4k. Audience areas turned off for balconies.

Eastern Acoustic Works | One Main Street | Whitinsville, MA 01588 USA | tel 800 992 5013 /+1 508 234 6158 | fax 508 234 8251 | www.eaw.com



~=[=/"\N

Example 1

Fig 4. Previous method, Resolution 2.7 Fig 5. Improved Algorithm, Resolution 2.8

Example 2 (Contour on)

ution 2.8.

Fig 6. Previous method, Resolution 2.7. Fig 7. Improved Algorithm, Resdl
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UX/UXA Improvements

Small bug fixes. Improvement to GUI and communications.

Additional support for:

MKD864
MKD986
MKD826
MKD1064
MKD1096
MKD1026

SB825
SB828

RS121
RS151
RS115
RS123
RS153
RS118HP

EAW Resolution v2.7.0.8 Release Notes
Previous Version: EAW Resolution v2.6.1.111

Resolution 2.7.0 contains a number of improvements for UX processor and amplifiers and includes
support for new EAW products. For any questions, contact the Application Engineering team at
design@eaw.com.

Key features in this release are listed below:
KF810P-80, KF810P-100, and SB818P-F Support
Resolution 2.7.0 introduces support for the new KF810P-80, KF810P-110 loudspeakers and SB818P-F

low frequency enclosure, providing total system optimization from anywhere in the venue, plus
intuitive room design and prediction.
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Coverage Goals i Array Settings
Array Options Aray Name
A [¥] Allow Non-Incremental Splays Array

[ Allow Front Splays
Speakers Avalable

z
Coverage @ Flown @ Ground Stack
[ Modify Type & [KFa10p-80 ~|E = :
[ 4 [ra1080x10 =
Type B [KFB10P-110 -] o
Allow Upper Overshoot
50 Alow Lo M (kFa10-110x10 ~]
0z
Coverage Goal
Fiybars
Consistent Max
0 Flybar Hang Style
Fly High FlvLow TypeA |KFB10P-Adapter  ~ | |Ground Stack s
SPL Requirement Type 8 [KF810p Adapter | [Ground stack ~
L
Spoken Word Rlnjd( Maximum Arroy Location

X 0.00m - ¥ 0.00m
Aim Direction 0.00°
Space Restriction:

Surface Height 0.00m

m

Coverage Goals

Array Options
Allow Non-Incremental Splays
[ Allow Front Splays
Coverage
[ Modify

Coverage Start (0,00

Coverage End [10.77

[ Allow Upper Overshoat
Coverage Goal
Consistent Max
Fly High Flv Low

SPL Requirement
Spoken Word Rock Maximum

Additional Changes and Improvements:

Improvements and bug fixes to the UX Processor and Amplifier control and interfaces.

Note: This version may automatically restart after installation depending on your system configuration.

Known Issues:

When dragging an online UX device from the network to the workspace, temperature is set to 0° and
humidity is set to 100%.
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EAW Resolution v2.6.1 Release Notes
Previous Version: EAW Resolution v2.6.0.193

Resolution 2.6 contains a number of improvements for modeling and includes support for new EAW
products. For any questions, contact the Application Engineering team at design@eaw.com.

Key features in this release are listed below:
RSX212L & RSX18F Support
Resolution 2.6 introduces support for the new RSX212L loudspeaker and RSX18F low frequency

enclosure providing total system optimization from anywhere in the venue, plus intuitive room design
and prediction.

[ i — ]|

Grpigria ) mml & w0 O oam

Yergr et e o Oaem

Coverage Goals
Array Options
Allow Non-Incremental Splays
[T Allow Front Splays
Coverage
[T Moify
Coverage Start [0.00
Coverage End [10.77
] Allow Upper Overshoot

Coverage Goal

Consistent Max

Fly High Fiv Low

SPL Requirement

Spoken Word Rock Maximum

e o= |

Array Settings
Array Name

Array

Speakers Avalable

@ Flown @ Ground Stack
TypeB o z
Flybars
Fiybar Hang Style
TypeA |ABX200 | [Ground Stack  —
TypeB - -

Array Location
X 0.00m + ¥ 0.00m
Aim Direction 0,00°
Space Restriction:

Surface Height 3.00m —

e )

Cirgr et e on O oM

[ e A — . |eia |
@A:rayﬁ\-ss\sta&t-ne\‘ﬂa}'h‘ ® o 0 N

Array Settings
Array Name

Aray

Speakers Avallable

@ Flown () Ground Stack
|WHITE Veicing REV B -]
Type B [RSX212L ~| B o
[ Rsx212L x5+ WHITE ~]
Flybars
Flybar Hang Style
Typea [FEx200 -
Type B - -

Array Location

Hang Point X 0.00m : Hang Paint Y 0.00m =

Aim Direction 0.00°

Space Restriction:

Min Trim  3.00m = MaxHang 10.00m &

I

Coverage Goals
Array Options
Allow Non-Incremental Splays
[] Allow Front Splays
Coverage
[T Modify
Coverage Start (0,00
Coverage End |10.77
[7] Allow Upper Overshoot
Coverage Goal
Consistent Max
Fiy High FivLow

SPL Requirement
Spoken Word Rock Maximum

[
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[ * Untitled - EAW Resolu

File Edit View MNetwork Options Tools Help

B0k k. 6 0 Q0 0% b Ema + 0o I8
" 2 ] Cross section: [0.00m - I :;Z:fmmr Tl 2

H 4 Arrays e
a 143 | b Amay b ]
3 4 Processors & A, [ 4

3 Arnplifier X =

138 | Drawings

Properties

Property Value

Name Array =
Speakers 4
4 Location (0.0m, 0.0m, 4.8m)
x 0.0m ‘
¥ 0.0m
z 4.8m

: . A Bottorm Hei... 3.0m
10m 3 T x» Mazx Hang 10.0m

= S
(-1.0m, 0.0m, 6.1m) Design Factor; 10;1 Online 1

UX/UXA Processors and Amplifiers "Pull" feature

UX and UXA series processors and amplifiers state can now be read upon discovery.

i ™
E] UXA4410: Amplifier e

Resolution is out of sync with UXA4410: Amplifier

Do you want to Push settings to the device?
or Pull settings from the device?

| Push || Pul || Cancel
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File Edit View MNetwork Options Tools Help

% Upload Array Parameters + B G D B g

4 Online Devices Project Explorer g X
EAW-ANYA-101208 b Venue HEE
WHT-PIT-ONE Arrays HE
UXA4410: Amplifier 4 Processors & A, (1] 4
Amplifier XE =
Drawings [
O
2 3 4
0 ] 1]
10 10 -10
20 -20 20 Properties F X
En 30 30 Property Value
E @ E Name Amplifier
Design Factor: 10:1 Online

Note: UX and UXA devices and files used with Resolution 2.6.1 are not backwards compatible
with 2.6 and prior versions of Resolution. Use of 2.6.1 files or devices with 2.6 will result in
unexpected behavior.

Changes and Improvements:

Adaptive Products
e Adaptive aiming lines have been corrected.
e Improved communications between software and Adaptive DSP parameters.
e Coverage lines are no longer allowed to "shoot" thru venue surfaces.

e Resolution no longer crashes trying to open Preset Dialog
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e Minor bug fixes to Anya Firmware. Anya Firmware is updated to v1.0.58.1, previous version
was v.1.0.57.1.
UX Products

e Bridging is now handled properly, depending on the greybox legs loaded.

Greybox dialog now displays the Rev #
o Greybox legs now limited to 8 max.
e Resolution will check UX FW and inform the user new FW is available

e Amp and Processor names are limited to 12 characters. If no processor name, model name is
used.

e Processor name is now synchronized properly
e The user is notified when a Greybox definition cannot be found.
e Improved communications with all UX devices.

e Deleting UX device with any adaptive or non-adaptive speaker present no longer triggers
acoustic model recalculation.

o UX/UXA meters now respond after the online device is unassigned and reassigned
e Limiter threshold returns to default when Greyboxes are unloaded
General

e Improved the interface for detailed 3D venues.

Improved interface for HPF and LPF control

e Save no longer fails if the target directory or drive is missing

e Arrays below minimum trim are now properly indicated

e SPL Cmenuitem added

e Improved the display of Audinate error codes

e Network view meters now cleared when Resolution goes offline

e Re-running the array wizard now presents the user with an option to leave the Air Loss
unchanged
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EAW Resolution v2.6.0.193 Release Notes
Previous Version: EAW Resolution v2.5.0.78

Resolution 2.6 contains a number of improvements for modeling, and includes support for new EAW
products. For any questions, contact the Application Engineering team at design@eaw.com.

Key features in this release are listed below:

UX/UXA Processors & Amplifiers

Resolution 2.6 introduces support for the new EAW UX series which includes the UX48 System
Processor and EAW UXA4406, UXA4410 and UXA4810 Amplifiers. This provides the user with complete
control and monitoring of key processor and amplifier controls and ensures the best possible
performance of an EAW sound reinforcement system through seamless integration of EAW’s Greybox
technology. Together, EAW Resolution and UX series allow setup and operation in a fraction of the
time required with other amplification systems.

Click the “+" symbol next to Processors & Amplifiers under the Project explorer window to add to the
system:

File Edit View Network Options Tools Help

% ig“i: Auto Identify  Upload Array Parameters + : g m .U B E

BProJectExplorer & X [V Online Devices
7>§Venue 4|4 H not online
Arrays SE ]
Processors & A... 4|/ %
Drawings 2

A dialog will appear allowing users to name and select the exact product being used:
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E Add Processors and Amps X

Processors & Amps

Device Name ||

Devices Available

Processor UX48

Amplifier UXA4406
Amplifier UXA4410
Amplifier UXA4810

Cancel

Once a processor or amplifier has been added to the system, the user will be provided with the option
to add Greyboxes and edit DSP parameters:

B uxaano: amplifier ? bd
EQ/Xover Filters Greybox
Flatten Channel EQ Select/Configure Greybox
= e o os] Gewoxtes[ ]
Freguency Input Source  None -
Type |24 dB Linkwitz-Riley ~ Limiter
Output e
Gain |0.00dB = =
ttack
Invert Polarity [ ] =
Release
Delay (0.01ms 5
Delay Dist |0.01ft S Amp
Bridge [ ]
Load Type 25V Line -
| |
A B I z D 1 2 I 3 4
o o o
-10 10
-20 20
-40 -40 -30 -30 -30 -30
[ J i Mute J Mute J Mute ( Mute |l Mute [ Mute |
[ |

ANYA V2 Amp Module
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This will be seamless to the user allowing for mixed arrays of v1 and v2 ANYA amp modules (assuming
all voicings are correctly loaded).

Other Changes and Improvements:

e Resolved an issue where Resolution could crash when creating a New System using the
keyboard shortcut.

e Network>Configure... has been renamed to Network>Configure Dante...

e Resolved an issue where Firmware Updates sometimes reported success when they had failed.

e Resolved an issue where the Parameter Sync dialog could show duplicate entries.

e Resolved an issue where the Array meters in Network View continued to show the last level
after the network had been disconnected.

Known Issues:

o EASE export may fail for larger Anya arrays.

o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.
o Workaround: Retry log request.

e The Array Assistant will sometimes indicate that the array is ‘'not aimed at a surface’ for venues
built in the -X direction because arrays default to aiming in the +X direction.

o Workaround: Adjust panning so that array is aimed in -X direction (180 degrees). This
can be done in the second page of the Array Assistant.

e The PC may need to restart upon completion of the Resolution installation due to the updates
to Dante Services if they are outdated.

o Workaround: None. Allow computer to restart. Do not install new versions of
Resolution in situations when it is critical that the computer not be restarted. If other
programs are running, Windows will prompt the user to save their work before
closing.

e Resolution may warn that an array is ‘below minimum trim’ when it is actually not, based on
the value set in the ‘Properties’ pane.

o Workaround: Re-run Array Assistant with modified Min Trim value. Warning should
disappear.

EAW Resolution v2.5.0.78 Release Notes
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Previous Version: EAW Resolution v2.4.0.87

Resolution 2.5 contains a number of improvements for modeling of all EAW products and control of
Adaptive systems. For any questions, contact the Application Engineering team at design@eaw.com.

Key features in this release are listed below:
External Image Import

Users can now import external graphical images as plan and sections views in order to aid the rapid
building of Resolution models from architectural drawings. BMP, JPG, PNG and GIF file formats are
currently supported. To add an image, locate “Import Drawing” under the “File” menu, or the
“Drawings” item in the Project Explorer pane and click the “+” button to begin the import process:

Project Explorer F X
> Venue |2 |

Arrays GLalE

Drawings +

A dialog will appear allowing users to scale and locate the drawing within the 3D Resolution model in
both plan (XY planes) and section (XZ and YZ planes) views. After importing an image, users can
simply overlay venue surfaces to the model as they normally would. This feature allows users to
quickly generate 3D Resolution models based on architectural drawings, as shown below:

Adaptive Health Display

For Adaptive Systems users, the health of the current online system can now be easily viewed in a
single location via this new feature. Though fault detection and Adaptive Healing are not new
features, this display increases the ease of use for system technicians and engineers in show
environments by assembling all available information in one place and providing guidance on when it
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is necessary to act on issues and when they are unlikely to have any noticeable impact on system
performance.

While online and assigned, Resolution will continually monitor the status of all modules in the system.
The status of the system is visible in the lower-right hand corner of the main window.

e B -
. Online B i

T M S
S —— ]

The display can have one of three states, each of which is shown below:

Systemn Health ? >
System Health
Mo issues
Array 2 Array
Array 2 [col 1] Array 2 [col 2] Array[col 1:1]
Anya Anya Anna
Anna

Green: No issues. System health is at 100%.

(Continued on next page)
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System Health 7 X
System Health
Some modules need examination later.
Array 2 Array
Array 2 [col 1] Array 2 [col 2] Array[col 1:1]
Anya Anya Anna
Anna
Anna

Yellow: Errors or faults detected, but acoustical impact is less than 1 dB.
No immediate user action needed.

System Health 7 pe
system e
System needs healing
Array 2 Array |
Array 2 [col 1] Array 2 [col 2] Array[col 1:1]
Anya o Anna | 2 unassigned
Anna
Anna
Anna

Red: Errors or faults detected and impact is more than 1 dB.
Immediate user action is recommended.

Once the user has healed the system and uploaded array parameters, the state returns to green, but
with an indication that healing has been performed (denoted by an “H"):

System Health

[ | System Health

) No issues

Array

Array 2
.

Array [col 1]

1: EAW-ANYA-3-BenTest

2: EAW-ANYA-ames-0b4c82

Array 2 [col 1]

1: EAW-ANNA-104f2e

2: EAW/-ANNA-0d3c 18

w

If additional faults or errors occur, the progression of yellow (less than 1 dB acoustic impact) to red (1
dB or greater acoustical impact) will begin again with the ‘Healed’ state as the new baseline.
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Other Changes and Improvements:
e Max SPL now includes effects of user EQ (both Array and Spatial).

e Added a function to check whether a Dante transmitter has gone offline before uploading
parameters with a Dante input assignment. User will be alerted if an array’s assigned input
transmitter is no longer present on the network and the user attempts to upload array
parameters.

e Includes updated Anna data file (1.1.14), improving MF/HF phase linearity and modeled
consistency.

e Fixed an issue where Otto would not properly apply rejection perpendicular to array physical
aim direction in some circumstances.

e Fixed an issue where the tab order in the Air Loss Compensation window skipped fields.

e Fixed anissue where the Input Assignment dialog would create multicast flows when user had
not requested them.

e Fixed an issue where vertical surfaces could cause unexpected directivity with Adaptive
systems.

e Fixed anissue where some overlapping surfaces could cause incorrect SPL predictions with
Adaptive systems.

e RSX208L voicing now defaults to x6-8 (white), resulting in more accurate SPL predictions with
a majority of user configurations.

Known Issues:

e EASE export may fail for larger Anya arrays.

o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.
o Workaround: Retry log request.

e The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
built in the -X direction because arrays default to aiming in the +X direction.

o Workaround: Adjust panning so that array is aimed in -X direction (180 degrees). This
can be done in the second page of the Array Assistant.

e The PC may need to restart upon completion of the Resolution installation due to the updates
to Dante Services if they are outdated.

o Workaround: None. Allow computer to restart. Do not install new versions of
Resolution in situations when it is critical that the computer not be restarted. If other
programs are running, Windows will prompt the user to save their work before
closing.
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e Resolution may warn that an array is ‘below minimum trim” when it is actually not, based on
the value set in the ‘Properties’ pane.

o Workaround: Re-run Array Assistant with modified Min Trim value. Warning should
disappear.
EAW Resolution v2.4.0.87 Release Notes
Previous Version: EAW Resolution v2.3.0.123

Resolution 2.4 contains a number of usability improvements and bug fixes, greatly improving user
workflow in model building. For any questions, contact the Application Engineering team at
design@eaw.com.

NOTE: Resolution 2.4 includes updated firmware for Anna. Updating to this version of firmwatre is strongly
recommended.

Key features in this release are listed below:

Multi-Select for Surfaces and Arrays

Users can now manipulate properties such as Solo, Lock, Audience/Non Audience, Ear Height and
Hidden on as well as mass deletion on multiple surfaces or loudspeakers simultaneously. This saves
significant time when editing models. To use multi-select, hold CTRL while selecting individual
surfaces or arrays, or SHIFT to select a range of surfaces or arrays. Users can also access multi-select
functions from the right-click menu.

Massive Speed Improvements

Resolution is now significantly faster due to better utilization of multi-core CPUs, achieving speed
increases of up to 300% over previous versions. This includes both acoustical model and SPL
calculations.

Adaptive Coverage Start/Stop Z-Override

Adaptive array coverage can now be limited vertically, employing the same ‘z-override’ feature as in
Spatial EQ. This can be useful in venues with balconies that overlap the main floor. In the following
example, the Z values exclude the balcony such that the array only covers the main floor:

a 150

i Y:-25.4
Display Mode: Broagband SPL A J

139

Coverage
start/stop

10

10

Coverage
overridden to
be on floor only
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Other Changes and Improvements:

e RSX208L voicing now defaults to x6-8 (white), resulting in more accurate SPL predictions with
a majority of user configurations.

e Fixed an issue where Dante Services would require a restart after being installed but did not
inform the user, resulting in an error until the computer was restarted.

e Fixed an issue where Resolution would sometimes take long periods of time to change
Adaptive coverage in very large venue and system models.

e Fixed an issue where the 3D rotation function in Free View would not work if the model had
vertical (90-degree) surfaces.

e Improved Anna near-field coverage consistency in situations where audience areas are at
extreme down-angles relative to array.

e The Parameter Sync feature now includes even more robust error checking.
e The Help File has been significantly updated to include new features.
e Includes updated firmware

o Anna--1.0.19.0. Improves long-term reliability in situations where the system is power
cycled very frequently.

Known Issues:

e EASE export may fail for larger Anya arrays.

o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.

o Workaround: Retry log request.

e The Array Assistant will sometimes indicate that the array is ‘'not aimed at a surface’ for venues
built in the -X direction because arrays default to aiming in the +X direction.

o Workaround: Adjust panning so that array is aimed in -X direction (180 degrees). This
can be done in the second page of the Array Assistant.

e The PC may need to restart upon completion of the Resolution installation due to the updates
to Dante Services.

o Workaround: None. Allow computer to restart. Do not install new versions of
Resolution in situations when it is critical that the computer not be restarted. If other
programs are running, Windows will prompt the user to save their work before
closing.
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EAW Resolution v2.3.0.123 Release Notes
Previous Version: EAW Resolution v2.1.4.98

Resolution 2.3 contains many significant improvements and bug fixes, greatly improving the user
experience. For any questions, contact the Applications team at design@eaw.com. Note that a
firmware update is required for Anna and Anya to access key Resolution 2.3 features.

Key features in this release are listed below:

Patial EG 'ﬁ

 Resolution 2.3/}

Resolution 2.3 introduces Spatial Equalization for Adaptive Systems, a new and unique technology
that allows users to equalize parts of the coverage by simply selecting the audience areas in which the
change is desired and applying the desired equalization. The Adaptive system then determines the
processing necessary to achieve the goal and implements it, in real time. This saves massive time and
effort when on-site setting up a system and produces superior results compared to any conventional
line array system. For the first time, users can truly EQ the room instead of the sound system.

For more detail on this feature, please see the Spatial Equalization Technical Paper and the Spatial
Equalization Overview video.

EQ Zone

Total
Coverage

Improved Air Loss Compensation

This version of Resolution provides a new Air Loss Compensation algorithm for Adaptive systems,
generating significantly greater high-frequency throw while also improving HF consistency
throughout the entire venue. Additionally, this feature allows users to optimize the HF response of
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their system for different situations, trading between headroom, throw and extension, providing up to
12 dB of additional HF energy at distances of 300 feet or more from the array.

Adaptive users can access this feature by clicking on the “AL" button at the array level under the
Project Explorer. In this control panel, users have a number of new controls:

o Headroom Penalty - Indicates the reduction in high-frequency headroom expected with the
current user parameters (Note: User must hit ‘Apply’ for these to be applied to the acoustical
model).

o Target Reference - Indicates the distance reference for the high-frequency tonality the user
desires for the entire coverage area. In other words, the high-frequency roll-off characteristic
for this distance will be used as a target for the rest of the coverage area. This can be set by
dragging the point on the graph, or by entering numerical values into the dialog box. Closer
distances will result in more extended high-frequency response at the expense of headroom,
while greater distances will reduce high-frequency extension but will increase headroom.

o Rear Threshold - Indicates the distance limit to which the user wishes to maintain the target
high-frequency tonality. This can be set by dragging the point on the graph, or by entering
numerical values into the dialog box. Closer distances will result in greater high-frequency roll-
off at the rear of the coverage but will improve headroom, while the greater distances will
reduce high-frequency roll-off at the rear of the audience at the expense of headroom.

e Enhancement Level - An overall level adjustment for the amount of air loss compensation
being applied to the system. Increasing this will improve high-frequency throw at the expense
of headroom.

e Presets - Provides a number of pre-defined starting points for user setup convenience. These
are also provided in the Array Assistant.

The control panel itself can be seen on the following page.
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Headroom
Penalty

Air Loss Compensation

Target Reference |83.4ft

Rear Threshold 166.9

Headroom Penalty 3.0 dB

Enhancement

v
Front and Rear
Min Nominal Man
Prosets References
Max Headroom
e Enhancement
Maximum Consistency
Level
Maamum Extension
Presets
Target frequencies up to 9.5kHz are consistent out to 167ft. Accept Cancel

A typical array’s high-frequency response in earlier versions of Resolution:

A typical array’s high-frequency response in this version of
Resolution. This system extends high-frequency throw, as can be

seen by the extension of the coverage contour lines much further
back in the venue.

Preset Recall
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This version of Resolution allows Adaptive users to easily store and recall system states via Resolution
for quick access. With this feature, radically different coverage and voicing settings can be recalled
within seconds with only a few mouse clicks, enabling users of all skill levels to leverage the enormous
power of Adaptive Systems.

As an example, Preset Recall could be used with a permanently-installed system to accommodate
different venue uses - the main floor only, the main floor + the balcony, and only a section of the main
floor, as examples — depending on attendance for a particular event. This ensures that the sound
system is directing energy only where there are audience members, minimizing reverberation and
enhancing clarity.

The Preset Manager window (accessible via the Network Menu when online) is shown below:

Preset Manager ? *

Active Preset
Indication

1. | Main Floor Only

3. | ReducedSeating _ Available
4. | <Empty Preset> 4'/,/ Presets
5. | <Empty Preset> / (1 0 tOtaI)

6. | <Empty Preset>

7. | <Empty Presst> /_ Functions
8. | <Empty Preset> /

9. <Empty Preset>

10. | <Empty Preset>

Success

Recall.. | | store.. || Rename.. Clear... Close
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Other Changes and Improvements:

Added feedback to the user if the Adaptive array input Dante subscription fails for any reason
(i.e. more than 32 receivers are attempting to subscribe to a device via a unicast flow).

Adaptive array temperature faults now prompt the user with the option to perform Adaptive
Healing on the array.

Adaptive coverage lines are now visible on elevated surfaces.

Number of modules that can be added to an array is now limited to 50 (formerly had no limit,
so users could accidentally type very high numbers).

Fixed issue where LED settings for Adaptive modules could revert to ‘Off’ without the user’s
input after an Array Parameter upload in some cases.

Fixed issue where Resolution could crash when re-running the Array Assist with a ground-
stacked RADIUS system with RSP-1 and RSP-2 pole mounts.

Fixed issue where left and right Adaptive arrays could sometimes have very small differences
in coverage due to slight venue asymmetries.

Fixed issue where CSV export added unexpected characters.

Fixed issue where side view mouse z-value was wrong when hovering over a surface with an
ear height other than zero.

Fixed an issue where Array View text could be cut off when running Resolution on Windows
10.

Fixed an issue where the Project Explorer would not show modules in manually-added
columns for Adaptive arrays.

Fixed issue where Design Factor dialog text could be cut off on Windows 10.

Fixed issue where Resolution could temporarily hang when the acoustical model calculation
reaches 100%.

Fixed issue where locked virtual microphones could still be edited.

Fixed issue where right-clicking above the horizon in Free View and adding a virtual
microphone or surface could add that object behind the user’s perspective.

Includes updated firmware (update is required to use new Resolution 2.3 features):
o Anya-1.044.1
o Anna-1.0.18.0

Updated firmware for Anya also improves fan logic for reduced noise in quiet environments.
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Known Issues:

e EASE export may fail for larger Anya arrays.
o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.

o Workaround: Retry log request.

e The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
builtin the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.

e When installing Resolution, Dante Services requires a restart to function but does not alert the
user.

o Workaround: Restart the computer after installation before using Resolution.
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EAW Resolution v2.1.4.98 Release Notes

Previous Version: EAW Resolution v2.1.3.84

Resolution 2.1.4.98 contains many significant improvements and bug fixes, greatly improving the user

experience. For any questions, contact the Applications team at design@eaw.com. Key features in this
release are listed below:

Improved Metering for Adaptive Products

The module metering for Anya, Anna and Otto has undergone a significant redesign to provide more
precise, clearer information. Now, users can determine available headroom before the onset of
limiting with just a quick glance. Limit thresholds are now indicated by yellow bars on the left side of
each channel, with gain reduction (when active) on the right side of each channel as shown below.

[ Diagnostics: EAW-ANNA-Oba3d0

Qvetview

Meters

Maintenance

Temp Log

Impedance Log

Errar Log

Acoustic Measurements

Gain Limit
Reduction
Available
Headroom
Signal Level

The update speed for the metering display has also been increased by approximately 5x on Anna,
providing much more responsive feedback to the user. This change will be implemented in Anya and
Otto in early 2017 as well but will require a firmware update.

Additionally, the input meter scale now changes depending on the type of input selected. When

“Analog” is selected, the input meter units are scaled in dBu, corresponding to input voltage. When
AES or Dante is selected, the input meter is scaled in dBFs.

Non-Audience Surfaces

Users can now add surfaces to a Resolution design for visual reference and SPL mapping, but exclude
them from coverage via the “Audience” checkbox in each surface’s Properties pane. This enables users
to now enter and display architectural surfaces in a venue (such as ceilings and walls) that are useful
for visual reference and/or to see SPL mapping, but that should not be covered by the sound system.
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When “Audience” is unchecked, SPL will still plot on surfaces. The “Hidden” option will prevent SPL
from plotting on surfaces, but they will still be covered by the sound system unless “Audience” is also
unchecked.

NOTE: Non-audience surfaces are not included in Resolution’s verification of shadowing by surfaces. In
other words, if a surface is not indicated as “Audience”, Adaptive algorithms will completely ignore it,
which may result in aiming lines intersecting non-audience surfaces while actually covering the
audience surfaces behind it.

Properties g X
Property Yalue
Marne new surface
4 Start (0.0Ft, 0.0ft, 0.0ft)
% 0.0ft
¥ 0.0ft
z 0.0ft
Length LO0.0ft
Inclination ... 3.0°
Wicth 20.2ft

Width Rear 26,2t
Rotatian An... 0.0°

Audience

4 EarHzight 0.0ft
Flaar
Seated
Stancling
Hidden
Lacked

By default, newly-inserted surfaces have the ‘Audience’ parameter enabled.
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Improved Surface Isolation for Adaptive Systems

This version of Resolution significantly improves Anya and Anna’s ability to avoid areas between
surfaces, both increasing the isolation of the audience surfaces from a building’s architecture and
further improving SPL and consistency. With this improvement, SPL is reduced between audience
surfaces by as much as 10-15 dB (the reduction will vary by audience geometry and array
configuration).

o - = o= - O

NOTE: It is not necessary to define non-audience areas to achieve this effect. Resolution will
automatically reduce SPL between active audience surfaces

Adaptive Aiming Lines

Resolution now allows users to see the general aiming and allocation of sources in Adaptive arrays.
Though this view is simplified (2 lines per enclosure), it provides users with a quick visual indication of
how the array is covering the audience and if any areas of the venue are shadowed (Adaptive arrays
will not ‘shoot’ through one surface to reach another). Additionally, users can quickly assess the
‘throw’ or coverage distance to various audience areas by simply reading the distance associated with
each aiming line.

Array Assistant with Mixed Full Range + Subwoofer Arrays
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Resolution’s Array Assistant will now fully optimize splay angles for arrays with mixed full-range and
subwoofer modules, making products like RADIUS (RSX208L + RSX12), KF (KF730 + SB730) and others
even easier to use than before.

An example system is shown below before and after splay optimization:

@ Array Assistant

=

Array Setings

Array Name

Array

Speakers Available
© Flown ©) Ground Stack

FE]

‘

B

4

Flybars
Flybar Hana Styls
Typea |FEx100 - | [sngepoint

Type B |FEX100 - | [singepaint

Array Location

HangPaintX 0.00ft || HangPointY o.00ft (3]

Al Direction 0,007 H

Space Restriction

MinTim 1o.00f (5] MaxHang 33.00t 3]

@ Array Assistant

Caverage Goals
Array Options
Allaw Mon-Tncremental Splays
] Allow Front Spleys
Coverage
7] Modify
Coverege tat
Coverage End | 150,57 B

[7] Allows Upper Overshoot

Coverags Goal

Consistent. Max

Fly High Fiv Low

SFL Requirement

Spoken Word Rock Maximum

NOTE: it is necessary to include both subwoofers and full-range modules on page 1 of the Array
Assistant. Subwoofers will not be included in the array unless a quantity of 1 or more is added to the

array by the user.

Other Changes:

o Added “Use Multicast” option when assigning inputs of Adaptive arrays. This permits more
than 32 modules to be subscribed to a Dante transmitter (such as an Adaptive module).

e Added warning when attempting to link processing for arrays of different type.

Improved software update status indications.

e Suppressed tilt sensor warnings for Adaptive systems.

e Added ability for Resolution to save directly to image files (in addition to clipboard).

e Added option to disable acoustic calculations (“Enable Calculations”, under the “View” menu).

Fixed issue where Otto gain structure was lower than expected in certain rare cases.

Fixed issue where Resolution could crash when disconnecting from a network.

e Fixed issue where Resolution could crash when deleting Otto modules from an array.
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e Improved Otto acoustical model calculations. Resolution will no longer sometimes pause for
long periods of time at 40%.

e Improved speed at which Resolution recalculates the acoustic model for Adaptive Systems
after changes are made to a design.

Known Issues:

e EASE export may fail for larger Anya arrays.
o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.

o Workaround: Retry log request.

o Coverage lines are not visible on elevated surfaces (greater than z=0).

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of
model) to see location of coverage lines.

e The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
builtin the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.
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EAW Resolution v2.1.3.84 Release Notes

Previous Version: EAW Resolution v2.1.3.83

Changes:

Adds EAW RADIUS family loudspeaker data — NOTE: Users may need to enable loudspeakers
and flybars in Resolution Inventory Manager (see Help File for details) in order to use them.
Models include:

RSX208L line source

RSX129 and 126 point sources
RSX89 and 86 point sources

RSX12 flyable subwoofer

RSX18 ground-supported subwoofer

FBX100 flybar for RSX208L and RSX12

Known Issues:

EASE export may fail for larger Anya arrays.

o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

Reading logs from Adaptive systems can sometimes take a long time or fail.
o Workaround: Retry log request.
Coverage lines are not visible on elevated surfaces (greater than z=0).

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of
model) to see location of coverage lines.

Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for
two arrays).

o Workaround: N/A. Acoustic model calculation time varies by array. Allow calculation
to complete.

The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
built in the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.

An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This
occurs because routing is established as unicast flows (which have a limit of 32).
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O

Workaround: Configure Dante flow from on-ramp module as multicast prior to
selecting inputs in Resolution. Audio routing via Resolution (via normal input
assignment process) will then be multicast.

EAW Resolution v2.1.3.83 Release Notes

Date: June 6, 2016

Previous Version: EAW Resolution v2.1.2.76

Changes:

e Adaptive Systems Enhancements

o Improved log files. Saved log files can be opened via File > Open even when the devices are not

online.

o Improved surface detection in design mode.

o Improvements to Anna fan speed management.

o Added support for multicast routing.

o General Updates

@)

O

Improvements to the Equalizer View.

Resolution “updating” procedure now includes status messages.
Minor bug fixes.

Includes updated firmware (see Help File for update procedure)
Anna (1.0.15.0)

Improves stability for systems left powered on continuously for extended periods
of time.

Known Issues:

e EASE export may fail for larger Anya arrays.

O

Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.

O

Workaround: Retry log request.

e (Coverage lines are not visible on elevated surfaces (greater than z=0).

O

Workaround: Rotate 3D venue model perspective vertically (so as to view underside of
model) to see location of coverage lines.
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e Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for two arrays).

o Workaround: N/A. Acoustic model calculation time varies by array. Allow calculation
to complete.

e The Array Assistant will sometimes indicate that the array is ‘'not aimed at a surface’ for venues
built in the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.

e An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This
occurs because routing is established as unicast flows (which have a limit of 32).

o Workaround: Configure Dante flow from on-ramp module as multicast prior to
selecting inputs in Resolution. Audio routing via Resolution (via normal input
assignment process) will then be multicast.

EAW Resolution v2.1.2.76 Release Notes
Date: February 17,2016
Previous Version: EAW Resolution v2.1.1.75
Changes:

e Adaptive Systems Enhancements

o Corrected issue where when utilizing a Dante audio input, Adaptive arrays receiving
audio from any source channel other than 1 will indicate an unsynchronized input but
actually have the correct channel selected in Dante Controller.

o Improved communications via Dante API, resulting in significantly faster online system
discovery.

o General Updates

e Minor bug fixes.

Known Issues:
e EASE export may fail for larger Anya arrays.

o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

e Reading logs from Adaptive systems can sometimes take a long time or fail.

o Workaround: Retry log request.
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Coverage lines are not visible on elevated surfaces (greater than z=0).

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of
model) to see location of coverage lines.

Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for two arrays).

o Workaround: N/A. Acoustic model calculation time varies by array. Allow calculation
to complete.

The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
built in the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.

An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This
occurs because routing is established as unicast flows (which have a limit of 32).

o Workaround: Configure Dante flow from on-ramp module as multicast prior to
selecting inputs in Resolution. Audio routing via Resolution (via normal input
assignment process) will then be multicast.

EAW Resolution v2.1.1.75 Release Notes

Date: December 17,2015

Previous Version: EAW Resolution v2.1.0.45

Changes:

Adaptive Systems Enhancements

Added Anna and capabilities to generate Anna and mixed Anya/Anna arrays to Array
Assistant.

Added Adaptive Parameter Sync feature, which continually monitors and reports
synchronization status between Resolution and Adaptive Arrays.

Added ability to utilize multiple hang styles within a multi-column Adaptive array (accessed by
the ‘Properties’ pane at the column level’).

Added option to ignore Tilt Errors for Adaptive products, as well as Previous/Next paging
buttons for warning banners.

Improved Acoustic Measurement function for Otto and Anna. As a result, users no longer need
to ‘Calibrate’ after driver replacement (still required for Anya).

Includes most recent voicings for Anya and Otto to maximize compatibility, reliability and
performance.
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o Overall Usability Improvements

e Improved SPL mapping on “Fastest” and “Normal” interpolation levels, reducing calculation
time by up to 80% (model-dependent).

e Added Laser and Cartesian data entry options for improved workflow when using laser
distance meters and CAD drawings (respectively) to create venue models.

o Added Copy, Paste and Link functions for mirroring equalization across multiple arrays.

e Increased maximum delay time in Array Processing window from 100 milliseconds to 1,200
milliseconds.

e Added ability to modify quantity of modules in a column or array from Properties pane.
e Removed ‘Overshoot’ Array Assistant function.

o Added capability to create trapezoidal audience areas.

e Added ‘Global Ear Height' setting.

e Improved reporting of maximum hang quantities for arrays.

e Improved legibility of virtual microphone SPL in certain situation.

e (orrected issue where Array Assistant-generated arrays can sometimes extend below
minimum defined trim.

e Corrected bug where EQ enable/disable state would not store with .eawresolution file.
o Network & Dante Improvements

o Added ability to select both primary and secondary network interfaces.

e Non-EAW products are now listed first in Device List.

e Improved communications via updated Dante API.
o General Updates

e Minor bug fixes.
o Updated Help File.

Known Issues:

e When utilizing a Dante audio input, Adaptive arrays receiving audio from any source channel
other than 1 will indicate an unsynchronized input, but actually have the correct channel
selected in Dante Controller.

o Workaround: None needed - this is a visual bug only. The arrays have the correct input
assigned, as indicated in Dante Controller.

e EASE export may fail for larger Anya arrays.
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o Workaround: Contact EAW Application Support for assistance in exporting EASE
balloons for large arrays.

Reading logs from Adaptive systems can sometimes take a long time or fail.
o Workaround: Retry log request.
Coverage lines are not visible on elevated surfaces (greater than z=0).

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of
model) to see location of coverage lines.

Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for
two arrays).

o Workaround: N/A. Acoustic model calculation time varies by array. Allow calculation
to complete.

The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues
built in the -X direction.

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the
Array Assistant. The array will be inserted and the acoustic model will still calculate
normally.

An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This
occurs because routing is established as unicast flows (which have a limit of 32).

o Workaround: Configure Dante flow from on-ramp module as multicast prior to
selecting inputs in Resolution. Audio routing via Resolution (via normal input
assignment process) will then be multicast.

EAW Resolution v2.1.0.45 Release Notes

Date: December 18,2014

Previous Version: EAW Resolution v2.0.3.50

Changes:

Added Otto Adaptive Subwoofer and Otto Array Assistant.
Several improvements to Network Configuration View for Adaptive systems, including:

Improved array self-recognition speed and accuracy.
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e Added progress bars forimproved array feedback.

e Added the ability to reboot modules remotely.

o Added LED options to Array Configuration dialogue for Adaptive Module.

o Added the ability to change inputs even if one or more module is offline.

e Improved handling of communication errors via progress bars and pop-up dialogs.

e Users now have the option to drive multi column Anya arrays either Adaptively or Uniformly
(see Help File for more detail).

e Anya and Otto 3D enclosure and flybar models are now significantly more detailed and
realistic.

e Adaptive systems acoustical model calculations are now more efficient; calculation time is
greatly reduced.

e X, Yand Z-axis lines in the negative direction are now dashed for easier identification.

e Numbering of array elements now only includes loudspeakers (accessories such as flybars and
adapter bars are tracked with letters instead of numbers) for easier array size identification.

e General minor bug fixes.
e Updated Help File.
e Includes updated firmware (see Help File for update procedure)
o Anya(1.0.39.0)
e § Adds level- and temperature-dependent fan speed control.

e § Power Plants now keep input panel "Test" indicator illuminated
while powered on for improved visibility of module status.

o Otto (0.1.9.0)
e § Initial release.
Known Issues:

e EASE export may fail for larger Anya arrays.
o Workaround: Contact EAW Application Support.

e Reading logs from Adaptive systems can sometimes take a long time or fail.
o Workaround: Retry log request.

e Coverage lines are not visible on elevated surfaces (greater than z=0).

o Workaround: Rotate 3D venue model vertically to see location of coverage lines.
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e Virtual microphone SPL text sometimes does not display properly with complex surface
geometries.

o Workaround: Rotate 3D venue model to see text.

e Array Assistant-generated arrays can sometimes extend below minimum defined trim in
situations with very tight height constraints.

o Workaround: Re-run Array Assistant with reduced array size until constraints are met.

e Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for
two arrays).

o Workaround: N/A. Acoustic model calculation time varies by array.

EAW Resolution v2.0.3.50 Release Notes
Date: July 7,2014

Previous Version: EAW Resolution v2.0.2.48
Changes:

e Enhanced implementation of Air Loss Compensation for very long throw distances
using Anya.

e Improved handling of audience surfaces shadowed from array coverage in complex venue
geometries.

o Updated “Create PDF” function for Anya arrays, no providing significantly more detail about
rigging points and loads.

e Inclusion of updated Audinate Dante Redistributable, no longer requiring some users to install
it separately.

e General minor bug fixes.

EAW Resolution v2.0.2.48 Release Notes
Date: April 25,2014
Previous Version: EAW Resolution v2.0.1.39
Changes:
e Added display of current cursor position 3D coordinate and SPL value.
e Added trace storage capability for virtual microphone frequency responses.

o Added audience ear height selection for each surface (used for SPL mapping, virtual
microphone placement and array coverage calculation).
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e Minorimprovements to mechanical calculations in Array Wizard, particularly for

mixed-model arrays.

e Removed dimensional limitations on ground-stack stage height.

e Added “Mic SPL" toolbar button for even faster SPL calculation.

e Improved “Copy image to clipboard” function.

e Improved Network Configuration View functionality, including:

e “Unassign All” right-click option for Anya arrays.

e Array placement on page is retained with file.

e Improved Anya-related functionality:

e Addition of “Sapphire” voicing.

e Improved EASE export function for Anya arrays. All columns in multi-column arrays
now export as single balloon.

e Improved acoustic model recalculation workflow.

e Minorimprovements to Adaptive Performance™ algorithm to handle unusual

e Audience geometries and air loss pre-emphasis for longer throws.

e Find Me (Trilateration) function process now includes more comprehensive dialogs.

e Improved “Auto Identify” behavior; LEDs now turn off after 10 seconds or immediately on
deselect.

e Anya banner warnings are more specific.
o Updated Help File.

o General minor bug fixes.

EAW Resolution v2.0.1.39 Release Notes
Date: February 19,2014
Previous Version: EAW Resolution v2.0.1.28
Changes:
Improved graphical functionality, including:
e Addition of zoom +/- functionality for frequency response window.

e Users can now define the Y-value of the cross-sectional view in X-Z view.
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Improved visibility of SPL microphones.
Added “Unsolo All Arrays” toolbar button.
Addition of shortcut keys and menu options for Free, Side and Top views.

o Enhanced menu operation including additional right-click functions such as:
“Clone” feature for virtual microphones in Venue Configuration window.
Direct access to processing for Arrays and Loudspeakers in Project Explorer window.
“Add Array”, “Add Surface” and “Add Mic” in Venue Configuration window.

o Improved “Create PDF” output and refined mechanical calculations for some
loudspeaker models.

o Added option to manually recalculate acoustic model if desired.

o Improved handling of non-English characters.

o Refined integration with Anya systems:
Further improved "Upload Array Parameters" behavior when making changes to model.
Added ability to define LED behavior.

Improved handling of low-frequency coverage for Anya arrays in certain near-field scenarios,
and overall EQ optimization.

This installer also includes Anya voicing version 1.5 (see release notes under “Inventory
Manager” for details). Previous voicing revisions are still included.

o General minor bug fixes.

EAW Resolution v2.0.1.28 Release Notes

Date: August 22, 2013

Previous Version: EAW Resolution v2.0.0.26

Changes:

Array Assistant improvements & bug fixes - “Array Wizard” changed to “Array Assistant”,
moved aim angle to, default coverage changed from 180 to 90 degrees, online array editing
improvements

Coverage assignment improvements - Asymmetrical horizontal coverage fields allowed
(relative to array)

Frequency Response window improvements - added CSV export, copy to clipboard to right
click menu, toggle icon bar auto re-size
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e Anya diagnostic screen improvements - more intelligent impedance feedback, acoustic
measurement improvements
e Added toolbar options - hide all floors button, undo/redo buttons, file & edit toolbars

e Acoustic/SPL workflow improvements - less recalculations & button presses required

e Microphones improvements & bug fixes - Microphones can be locked, “Find Me!” results
default to locked

e Array & surface naming improvements & bug fixes - “floor” changed to “surface”

EAW Resolution v2.0.0.26 Release Notes
Date: August 6, 2013

Previous Version: EAW Resolution v1.3.1.39
Changes:

e Initial release of EAW Resolution 2.0

For all questions, please contact design@eaw.com
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